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 To Log Into ProviderLink 
1. Open Internet Explorer and enter the following address: 

https://healthcare.covisint.com. 
2. On the login screen, enter your User ID and Password 

and click Login. If you mistype either your User Name 
or Password, the system will ask you to try again. 

3. If you try to log in and fail 5 times within 5 minutes, the 
system will suspend your user account. Go to 
https://healthcare.covisint.com. Click Forgot Your 
Password? to use your challenge question and answer 
to reset your password. 

 To Check ProviderLink For and Read 
 Incoming Messages 
1. Once logged into the system and viewing the Main 

Window, click the View link in the top right corner. 
2. Click the View drop-down arrow and choose your work 

list. (Note: Choose Default Incoming Fax Folder to view 
the list of incoming faxes. See “To Process an Incoming 
Fax Message”). 

3. Click Submit to display your work list. The Main Window 
will appear. 

4. When viewing your work list, the number of Unread 
Messages will appear at the top of the screen and in the 
Unread column in the patient list. Clicking either of 
these numbers will display the message list. 

5. To read a message, click the patient's name link in the 
Patient column. 

6. When the View Patient Information screen appears, 
click the Unread Messages link in the Status section. 

7. When the Unread Messages for Patient screen appears, 
you may read a message by clicking the Subject link. 
The message will appear. 

8. From the menu bar, you may Reply, Forward, Mark the 
message Unread, view information about the sender 
Contact, and Print the message. 

9. If there are any Attached Documents, you may click 
the links to read the attachments. 

10. To go back and read more unread messages, you may 
click either Unread or the patient's name in the 
breadcrumb trail at the top of the screen. 

 To Process an Incoming Fax Message 
1. On the Default Incoming Fax Folder Main Window 

screen, click the Get Next Fax button. The first page of 
the oldest fax message appears. 

2. Once you determine which provider the message is 
from, click the Originator drop-down list to see if the 
provider appears. If so, select the provider. 

3. If the provider is not in the Originator list, click the 
Search button to bring up the Facility Search window. 

4. Enter the necessary criteria to search for the provider 
and click Search. The system will display the search 
results based on the criteria you specified. If the 
provider you are searching for does not appear, modify 
the search criteria, and repeat the search. 

5. If the provider still does not appear, you may need to 
create the facility. (See “To Create a New Fax-Only 
Facility”) 

6. Identify the type of document and enter it in the 
Document Name field. 

7. Next to the Patient Name field, click Search. Use the 
Patient Lookup window to find the patient record. If no 
patient record exists, you may need to create a new 
one. (See “To Create a New Patient Record”) (Note: If 
you are a folder based facility, a pop up requesting 
which patient folder to place the document in will 
appear). 

8. Click the Mailbox drop-down arrow to display the list of 
mailboxes to which to route the message. Choose the 
appropriate recipient's mailbox. 

9. For multi-page fax messages, click the page numbers to 
check if multiple messages were sent in the same 
transmission. If so, you will need to split the message 
and route each part separately. To set up the split, click 
the More button to bring up a new row for each 
message part. The Document Name, patient Name, and 
Mailbox will carry forward to each new row and may 
need to be changed. 

10. In the Pages field, enter the pages to send for each 
message part. For all pages, enter “All.”  

11. Once you have filled in all of the fields for each message 
part, make sure the Remove document from the fax 
queue is selected and click the Save and Next button 
to pull up the next fax message. 

 To Create a New Patient Record 
1. From the Patient Lookup window, click New on the 

menu bar. The Add Patient screen appears. 
2. Fill in, at a minimum, the patient's Last Name, First 

Name, and Birthdate in the respective required fields. 
You do not have to select a work list. 

3. Click Save. The patient's name will appear in the Patient 
field. 

NOTE: This also works from the Main Window (New > 
Patient).  
To Create a New Fax-Only Facility 
1. From the Search Results window, click New Contact on 

the menu bar. The Add Fax Only Facility/Contact screen 
appears. 

2. Enter name of the provider in the Fax Facility Name 
field. 

https://healthcare.covisint.com/
https://healthcare.covisint.com/
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3. Choose the type of provider from the All Facility Types 
list box and click Select. There may be more than one 
applicable provider type. If you have added a facility 
type and want to remove it, you may highlight the facility 
type and click Unselect. 

4. Enter the fax contact's First Name. If you are unsure of 
the name, you may enter “Main”. 

5. Enter the fax number in the Fax # field. DO NOT enter 
any dashes or parentheses. 

 

6. When you have checked your entries for accuracy, click 
Save. The provider will now appear in the To Recipients 
field. 

NOTE: This also works from the Main Window (New > 
Facility). 
 To Add Documents To a Patient Record With 
 the Virtual Print Driver 
1. Start from the patient's View Patient Information screen, 

and click Documents from the menu bar. 
2. When the Documents list appears, click Add Document 

> Add By Print Job from the menu bar. 
3. When the Add a Print Job window appears, enter a 

name in the required Document Name field. 
4. Click Print. The Print Now window appears and the 

system is ready to receive the document. 
5. Without logging out of ProviderLink, open the document 

you wish to print.  
6. For most applications, click File > Print, and then select 

ProviderLink Printer from the list of printers, and click 
Print. 

7. The ProviderLink Internet Gateway window will appear 
and the document will be sent to the patient record. 
When you see “The send completed successfully,” click 
the Close button. 

8. Minimize or close the document window to get back to 
the ProviderLink Print Now window and click Close. 

9. Navigate back to the ProviderLink window (look for the 
“Documents Management” button on the task bar) and 
the document will appear in the list. 

To Add a Paper Document To a Patient Record 
1. Start from the patient's View Patient Information screen, 

and click Documents from the menu bar. 
2. When the Documents list appears, click Add Document 

> Add By Fax from the menu bar 
3. When the “Add a Fax” screen appears, type a document 

name in the Document Name field and click Print.  
4. You will see a bar-code cover page appear. Click Print 

from the menu bar and print the document to your 
printer. 

5. Take the bar-code cover page, put it in front of the 

document you wish to add, and fax it to the number on 
the cover page. After the fax sends the document to 
ProviderLink, the document will appear in the patient's 
list of documents. 

NOTE: It may take a few moments for the document to 
appear in the patient's Documents list, depending on the 
number of pages in the fax message. 
 To Send a Message Through ProviderLink 
1. Start from the patient's View Patient Information screen, 

and click Send Message from the menu bar. The 
Create Message screen appears. 

2. Select the provider name from the To Recipients drop-
down list. If the provider does not appear in the list, you 
may search for the facility in the same way as in “To 
Process an Incoming Fax Message” steps 3-5. 

3. The From Mailbox should already be set for you.  
4. Click the Browse button to select the documents you 

wish to attach.  
5. Enter an appropriate Subject, which will appear on the 

fax cover page. For example, “OP Requisition.” If 
available, you may also select Template on the menu 
bar to enter a standardized subject. 

6. You may enter a Message that will appear on the fax 
cover page. You may also choose to use a Template to 
enter a standardized message. 

7. If you want the recipient to reply, click the Request a 
Reply check box.  

8. Click Send. The message will be delivered to the 
recipients you specified. 

 To View Another Work List 
1. Start from the Main Window and click the View link in 

the top right corner (it will say “View:” followed by the 
Work List name.) The “Choose Work List View” screen 
will appear. 

2. Click the View drop-down arrow to display the list of 
work lists and folders available for your organization. 

3. Select the work list you wish to view. 
4. Click the Submit button to view the work list. 
 To Set a Reminder Task On a Patient Record 
1. Start from the patient's View Patient Information screen. 
2. In the Status section, click Tasks. The Tasks for Patient 

screen appears. 
3. On the menu bar, click New. The Add/Edit Scheduled 

Task For Patient screen appears. 
4. Enter the task Description and Due Date. You may use 

the calendar pop-up window by clicking the calendar 
icon. 

5. In the Non-viewable Comments field, you may enter 
any special instructions or other comments regarding 
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f. Message Needing a Reply - displays a list of 
received messages waiting on a reply that were 
sent to that mailbox.**  

this task.  

 

6. Click Save to save the task and set the reminder. You 
will return to the Tasks for Patient screen. 

g. Message Waiting on a Reply - displays a list of 
sent messages waiting on a reply that were sent 
from that mailbox. ** 

 To Complete or Delete (remove) a Task 
1. Start from the patient's View Patient Information screen. 
2. In the Status section, click Tasks. The Tasks for Patient 

screen appears. 
h. Overdue Review Task - displays a list of the 

overdue review tasks.**  
3. Find the task you wish to complete and click the 

Description link. The Add/Edit Scheduled Task For 
Patient screen appears for that task. 

i. Overdue Reminder Task - displays a list of the 
overdue reminder tasks.** 

** Option only displays in the drop-down list if it has 
been activated by your domain or facility 
administrator. 

a. To complete the task, click Complete on the menu 
bar and then select either With Notes or Without 
Notes. If you chose to complete the task with notes, 
enter the notes in the Viewable Comments field and 
click the Complete Task button. 

 To Remove a Patient Record From Your Work 
 List 

b. To delete the task, click Delete on the menu bar and 
then select either With Notes or Without Notes. If 
you chose to delete the task with notes, enter the 
notes in the Viewable Comments field and click the 
Delete Task button. 

1. Start from the patient's View Patient Information screen.  
2. In the Work Lists Linked To This Patient list, select your 

work list name and click Remove. 
3. Click the Save button on the menu bar or the bottom of 

the screen. 
4. After completing or deleting the task, you will return to 

the Tasks for Patient screen. 
4. If the patient has unread messages, or unfinished tasks, 

the system prompts you to confirm removal.  When the 
system asks you to confirm, click Remove.  To View a Patient's Message History and 

 Audit Trail 5. The system will display your updated work list with the 
patient record removed. 1. Start from the patient's View Patient Information screen 

and click History Items to view the Message History for 
Patient screen and every message sent or received 
relating to that patient. 

 To Log Out of ProviderLink 
1. From almost any screen, click Logout on the menu bar. 
2. After you have successfully logged out, you may close 

the browser window. 2. To view a message, click the message Subject link. 
3. Clicking History in the breadcrumb trail will take you 

back to the Message History for Patient screen. 
Note: Be sure to log out before you close the browser 
window to prevent any unauthorized access to protected 
healthcare information.  4. For a more detailed record of the patient record history, 

click Audit Trail on the menu bar. This will show you a 
detailed history of virtually every activity regarding the 
patient record to include what and when it occurred and 
the associated user name.  

  To Get Help 
1. Access the online help by clicking Help on the menu bar 

at the top of the screen. 
2. Contact your ProviderLink facility administrator who, if 

necessary, will contact the ProviderLink Help Desk.
 To View Overdue and Pending Items 
1. On the Main Window screen click the drop-down list to 

the right of Current View and select from the following 
options: 

a. Patient List - displays the patient list for the 
current work list (default option). 

b. Unread Messages List - displays a list of unread 
patient messages.   

c. Task List - displays a list of patient tasks.  
d. Reviews Due List - displays a list of patient 

reviews due. 
e. Overdue Unread Messages - displays a list of the 

overdue unread messages.**  
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Common Troubleshooting Issues 

Function Issue Steps To Resolve What To Do Now 
Can you access other 
websites (e.g., cnn.com, 
etc.)? 

Yes – Contact the ProviderLink 
Help Desk to determine if there 
are any system issues. 
No – Contact your IT network staff 
to determine if your facility is 
having network or Internet issues. 

The login screen does not 
appear. 

Are you trying to access the 
correct web address? 

Be sure you are entering 
https://healthcare.covisint.com into 
the web browser's Address bar.  

I forgot my user name and/or 
password 

Use either the “Forgot your 
UserID?” or “Forgot your 
password?” features. 

Go to the Covisint login screen,  
https://healthcare.covisint.com, 
and click the appropriate link. 

Unable to log into 
ProviderLink 

I have been suspended. Contact your facility 
administrator. 

Your facility administrator can 
unsuspend your user account. 

Patient Records I cannot find the patient record 
I was working with. 

Search for the patient 
record using Lookup > 
Patient. 

ProviderLink saves patient records 
indefinitely. 

I sent a message to a facility. 
How can I be sure it was 
received? 

Check the History Items for 
the patient using the 
History Items link from the 
patient's View Patient 
Information screen. 

The History Items list records 
every incoming and outgoing 
message for the patient and 
whether or not a message is sent 
successfully. 

Messaging 

A message I was reading is 
not in the Unread Messages 
list. Where can I find it? 

Check the History Items for 
the patient from the 
patient's View Patient 
Information screen. 

Once you have read a message, it 
is removed from the Unread 
Messages list. 

I faxed my document 20 
minutes ago and I do not see it 
in the patient's Documents list. 

Look for the document in 
your facility's Incoming Fax 
Folder. Route the 
document using the fax 
splitter. 

When ProviderLink is not sure 
where to route a document, the 
system will route the document to 
the Incoming Fax Folder. 

I do not see the ProviderLink 
Virtual Printer in my list of 
printers. 

You must install the 
ProviderLink Virtual Print 
Driver before you can print 
attach any documents.  

The ProviderLink Virtual Print 
Driver can be downloaded and 
installed from the Help menu on 
the Main Window screen. 

Documents Management 

The ProviderLink Print Driver 
gives me an error message: 
“Please attach a case within 
ProviderLink before attempting 
to print.”  

Follow the steps above to 
print attach a document into 
a ProviderLink patient 
record. 

You must first start in the patient's 
record and choose to add a 
document by print job before 
printing using the ProviderLink 
Virtual Printer. 
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